
diately available via the main tool-

bar. The Formatting toolbar 

gives you quick access to 

the formatting options, 

such as font, font size, 

alignment, numbered and 

bulleted lists, etc. In other words, even 

if you are completely new to OpenOffice.

org Writer, you can start using it right 

away. However, behind Writer’s simple 

interface hides a rather powerful appli-

cation containing a slew of clever fea-

tures. Writer, for example, includes a 

built-in PDF export feature, which allows 

you to generate a PDF version of your 

A reliable word processing application is a basic computing requirement. We'll show you how to get started 

with OpenOffice.org's Writer. BY DMITRI POPOV

or many users, daily computing 

means writing and editing docu-

ments in one form or another, so 

a decent word processor is an essential 

tool for their work. Although other word 

processors are available for Linux, such 

as AbiWord and KWord, they are no 

match for OpenOffice.org Writer, a 

heavy-duty word processor that you can 

use for pretty much anything. From sim-

ple letters and invoices to books and 

mail merge documents, Writer handles 

all these tasks equally well.

Users familiar with other word proces-

sors will feel at home with Writer: It 

sports a rather conventional interface 

(some might call it dated), and all 

its basic features are 

imme-
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document in a matter of a few clicks 

(Figure 1). To do this, choose File | Ex-

port as PDF. This opens the PDF Options 

dialog window that allows you to tweak 

the available export options.

Besides the PDF file format, Open-

Office.org supports a number of other 

formats, including Rich Text Format 

(RTF) and Microsoft Word 2003. The lat-

ter can be particularly useful for people 

who need to exchange documents with 

Microsoft Office users. Keep in mind, 

though, that although OpenOffice.org 

Writer usually does a commendable job 

of handling the Word format, it can oc-

casionally stumble on some complex 

documents containing a lot of format-

ting. With the use of Open Office.org’s 

export feature, you can also save Writer 

documents as MediaWiki-formatted text 

files – a boon for users who use wikis for 

web publishing.

Like any word processor worth its salt, 

Writer supports version tracking, on-the-

fly spell checking, footers, headers, foot-

notes, tables, and other features essen-

tial for basic word processing. Users in-

terested in mail merge will be pleased to 

learn that Writer comes with a powerful 

yet user-friendly Mail Merge Wizard. 

The Frames feature can help you lay out 

complex documents in Writer, and you 

even have a Media Player to play media 

files and insert them into documents. All 

of these tools are indispensable, but two 

features really make Writer stand out 

from the crowd: styles and master docu-

ments. Moreover, you can expand Writ-

er’s and other Open Office.org applica-

tions’ capabilities with extensions.

Styles is one of the features that make 

OpenOffice.org Writer a rather powerful 

word processing application. In fact, if 

you really want to get the most out of 

Writer and take your word processing 

skills to the next level, you should learn 

how to use styles. The Styles feature al-

lows you to specify paragraph and char-

acter formatting properties (Figure 2). 

For example, you can create a character 

style called My_bold_head that uses Bit-

stream Vera 9pt Bold font. The next time 

you have to format a heading, you sim-

ply apply the My_bold_head to it.

“But why bother creating a separate 

style if you can just use the Bold button 

on the Formatting toolbar?” you might 

ask. Well, say that you have a 99-page 

document with dozens of words and text 

fragments in bold. Now, what if you 

need to change all headings to bold 

italic? Without styles, you have to go 

through the entire document and manu-

ally change every single head individu-

ally. Needless to say, this is a lot of man-

ual work. With styles, performing this 

operation is simple: Open the My_bold_

head style for editing, choose the Font 

tab, select Bold Oblique in the Typeface 

list, press OK, and you’re done.

The Styles feature offers a few other 

creature comforts. The Organizer tab in 

the Style dialog window allows you to 

specify which style should follow the 

current one (the Next Style option) and 

which style inherits its properties (the 

Linked with option). For example, you 

can create a special style for the docu-

ment header and set the Next Style op-

tion to the Text body paragraph style. 

Next time you type a header in your doc-

ument and press Enter, Writer automati-

cally switches to the Text body style. 

Using the Linked with option, you can 

link several styles together. For example, 
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you can link the Heading 1 style with 

Heading 2, so that the latter style inher-

its the properties of the former. Then 

if you change the font in the Heading 1 

style later, for example, this change will 

be applied automatically to the Heading 

2 style and any other style linked to it. In 

this way, you don’t have to go through 

each style and change its properties 

manually.

To keep tabs on styles, Writer sports 

the Stylist tool, which can be evoked by 

pressing the F11 key or by choosing For-

mat | Styles and Formatting. Styles can 

be a bit intimidating in the beginning, 

but once you’ve learned the ropes, they 

can save a lot of time and make you look 

like a real OpenOffice.org Writer pro.

Styles is not the only feature that 

makes Writer a perfect word processing 

tool for complex documents. When 

working on a long document, like a book 

or research paper, you save individual 

chapters as separate .odt files and as-

semble them in a master document. 

The master/ subdocuments concept is 

not new. This feature has been available 

in Microsoft Word for a while, but it was 

(and probably still is) so buggy that even 

Microsoft recommends that you stay 

away from it. The master documents in 

Writer work like a charm, so if you are 

planning to write your next book in 

 OpenOffice.org Writer, you should 

 consider using its master/ subdocuments 

capabilities. 

Creating a master document in Writer 

couldn’t be easier: choose File | New | 

Master Document, and Writer  creates an 

empty master file ready for use. Then 

you can use the Navigator tool (press F5 

or choose Edit | Navigator), which al-

lows you to add subdocuments to the 

master and manage them with ease.

Like Firefox, you can add new features 

to OpenOffice.org applications with the 

use of extensions. The best place to find 

extensions for OpenOffice.org is the offi-

cial extension repository [1]. Here you 

can find extensions for all Open Office.

org applications, as well as rate and 

comment on them. 

Writer offers many advanced features 

that can help you to create anything from 

a simple letter to a book with a complex 

layout. But as with any powerful applica-

tion, you often have to dig deep to get 

the most out of Writer. The following tips 

will help you quickly master Writer’s 

many useful features.

Remove a word from a user dictionary

To remove a word from a user-defined 

dictionary, follow these steps:

1. Choose Tools | Options | Language 

Settings | Writing Aids.

2. In the User-defined dictionaries win-

dow, select soffice and press the Edit 

button.

3. Select the word you want to remove 

and click Delete.

4. Press Close | OK when done.

Use Reject changes for selective undo

If you want to undo an action several 

steps deep with the Undo command, 

you are bound to undo all the previous 

steps as well. However, you can perform 

a selective undo using the Accept/ Reject 

changes feature. This way, you can se-

lect the exact action you want to undo.

1. Do Edit | Changes | Accept or Reject.

2. Select the change you want to reject 

(it becomes highlighted in the docu-

ment).

3. Press the Reject button.

Keep in mind, though, that to be able to 

use this feature, you have to activate the 

Changes feature first.

Add a watermark to a document

Sometimes you need to add a water-

mark to your document (for example, 

CONFIDENTIAL, URGENT, or COPY). 

Here is how to do this:

1. Choose Insert | Frame to insert a frame 

into the document.

2. Enter the desired text and change its 

color, if necessary.

3. Click on the frame to select it.

4. Right-click on the frame and choose 

Wrap | In Background.

This technique also allows you to use a 

picture as a watermark: In step 1, choose 

Insert | Picture | From File.

Create a new default template

If you want every new document to have 

user-defined settings, you must create a 

new template and set it as the default.

1. Create a new document, add or mod-

ify styles, and change other settings as 

desired.

2. From the File menu, choose Templates 

| Save.

3. Give the template a name.

4. Select a category in the Categories list 

(e.g., My Templates).

5. Click OK to save the template.

6. Choose File | Templates | Organize.

7. In the Category list, double-click on the 

My Templates folder.

8. Right-click on the template you want 

to use and choose Set as Default 

 Template from the menu.

9. Click the Close button.

Use landscape and portrait pages in the 

same document

Here is the problem: You have a docu-

ment in which all pages are in Portrait 

mode, but you need to insert a page in 

Landscape mode. To do this, you must 

create a page style with landscape page 

orientation:

1. In the Stylist, click on the Page Style 

button, right-click in the window, and 

choose New.

2. In the Page Style dialog box, click on 

the Page tab.

3. Under Orientation, click on the Land-

scape radio button.

4. Specify other settings and press OK.

Insert a landscape-oriented page

1. Choose Insert | Manual Break.

2. Click on the Page break radio button.

3. Select the newly created landscape 

page style from the Style drop-down 

menu.

To get back to the portrait mode, repeat 

the procedure, but in step 3, select the 

portrait page style.

Link text frames

Although Writer is not a DTP application, 

it contains tools that allow you to create 

complex layouts. For example, using the 

Link Frames feature, you can insert 

frames in the document and then link 

them together.

1. Start by creating a frame (Insert -> 

Frame) and typing some text in it. Al-

ternatively, you can frame an existing 

text fragment.

2. Create an empty frame and click on 

the edge of the first frame.

3. Click the Link Frames button on the 

Object toolbar.

4. Click on the edge of the second frame.

When the first frame is full, the text flows 

into the second frame. To unlink frames, 

select a frame and press the Unlink 

frame button on the Object toolbar.

Writer Tips
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Installing Open Office.org extensions is 

rather straightforward. First, you have to 

download the desired extension. Then 

launch Open Office.org, choose Tools | 

Extension Manager, and select the My 

Extension section. 

Finally, press the Add button and se-

lect the downloaded .oxt file. Once the 

extension is installed, restart OpenOffice.

org to enable it.

Which extensions you choose to in-

stall on your system depend largely 

on your needs, but there are at least 

two extensions you might want to try: 

LanguageTool [2] and OpenOffice.org-

2GoogleDocs [3].

Although OpenOffice.org comes with a 

competent spell checker and thesaurus, 

it lacks a grammar module, which many 

users find rather useful. If you are 

among them, then try LanguageTool 

(Figure 3). Although it might not be as 

powerful as the grammar checker bun-

dled with Microsoft Office, it lets you 

perform a basic grammar check on your 

documents with ease, and it even sup-

ports several languages.

Right from the start, Google Docs has 

been a useful complement to Open-

Office.org. Because this web-based office 

suite supports the OpenDocument for-

mat, you can send documents back and 

forth between OpenOffice.org and 

Google Docs. Although this works fine 

when you have to upload or download 

documents every now and then, trans-

ferring dozens of documents between 

OpenOffice.org and Google Docs can 

quickly become a nuisance.

The Open Office.org2GoogleDocs 

(ooo2gd) extension solves the problem 

by allowing you to upload OpenOffice.

org documents easily to Google Docs, 

as well as to open existing Docs files in 

Writer (Figure 4). The upload feature 

Advanced Find & Replace options

The Find & Replace tool offers a few 

 advanced options to make your search 

more precise. You can use the Attributes 

button to select the text attributes that 

you want to search for. For example, 

if you tick the Font color checkbox, the 

search finds all occurrences of text in 

which the default font color was 

changed. Using the Format button, you 

can specify the text format criteria for 

your search. This option can be used, for 

example, to find all occurrences of the 

word “OpenOffice.org” in a particular 

font, typeface, size, or any other text for-

mat characteristic. Similarity search al-

lows you to perform fuzzy searches. For 

example, searching for the word “office” 

with Similarity Search turned on returns 

both “office” and “official.”

Enable line numbering

In certain situations, like collaborative 

editing, line numbering can be rather 

useful. To enable line numbering, choose 

Line Numbering from the Tools menu 

and tick the Show numbering checkbox. 

In the Line Numbering dialog window, 

you can tweak other settings, such as 

Character style, Format, and Position.

Set page number offset

The problem: You have a document con-

taining a blank or title page, and you 

want to start page numbering with the 

next page. Here is how this can be done:

1. Click in the first paragraph of your first 

page.

2. Choose Format | Paragraph | Text 

Flow.

3. Under Breaks, check Enable. Make 

sure that Type is set to Page and 

 Position is set to Before.

4. Tick the With Page Style checkbox 

and choose Default (or whatever page 

style you want).

5. Enter the page number you want in 

the Page Number field.

Note that 0 in the Page Number field 

doesn’t denote a page number, but sim-

ply means that the current page number 

won’t be changed.

Lock text segments

In certain situations, you might want to 

prevent other users from editing parts of 

a Writer document.

1. Select the text segment that you want 

to protect.

2. From the Insert menu, choose Section.

3. Tick the Protect checkbox.

4. Click the Insert button.

If you tick the With password checkbox 

and define a password, users can edit 

the text segment only if they enter the 

correct password.

Because Writer applies the Hyperlink 

character style to TOC entries, you might 

encounter a situation in which you want 

your TOC to have its own character style. 

Right-click on the TOC and choose Edit 

Index/ Table. Click on the Entries tab, click 

on the LS button, select the desired style 

from the Character Style drop-down list, 

and press All then OK.

Extract pictures from a Writer document

If you need to extract pictures from a 

Writer document, you can do this using 

the following trick:

1. Make a copy of your Writer file.

2. Change its extension to .zip.

3. Unzip the file.

4. The unzipped folder contains a Pic-

tures folder with all the pictures from 

the document in the PNG format.

Alternative open source fonts

OpenOffice.org includes the open source 

Bitstream Vera font family, which is a 

good all-around font. However, there are 

other high-quality open source fonts you 

might want to try:

DejaVu (http://  dejavu.  sourceforge.  net/), 

Arev (http:// tavmjong. free. fr/ FONTS/), 

MgOpen (http://  www.  ellak.  gr/  pub/  fonts/ 

 mgopen/), Junicode (http:// junicode. 

sourceforge. net/), Gentium (http://  tinyurl. 

 com/  2ro72).

Insert dummy text into a document

Do you need to fill your document with 

dummy text? Type “dt” (without the 

quotes) in the document and press F3.

Change default dummy text in Writer

The dummy text in Writer is just a regu-

lar text snippet stored in AutoText, so 

you can edit it the same way you would 

edit any AutoText entry. To modify the 

existing dummy text:

1. Press Ctrl+F3 to open the AutoText 

 dialog window.

2. Expand the Standard list and scroll 

down to Dummy Text.

3. Click the AutoText button and choose 

Edit. The dummy text opens in Writer 

and you can edit it to your liking.

4. Save the changes by pressing Ctrl+S.

Next time you type “dt” and press F3, 

you’ll have your modified text. By the 

way, you can find everything you want to 

know about the classic Lorem Ipsum 

dummy text at www.lipsum.com. The 

website also features a handy Lorem 

Ipsum generator.

Writer Tips (continued)

[1]  OpenOffice.org extension repository:  

extensions.  services.  openoffice.  org

[2]  LanguageTool:  

www.  languagetool.  org

[3]  OpenOffice.org2GoogleDocs: 

http://extensions.services.openof-

fice.org/project/ooo2gd
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supports not only ODT documents, but 

also SXW, DOC, and RTF. Moreover, 

Open Office.org2GoogleDocs can send 

spreadsheets in ODS, XLS, and CVS for-

mats, as well as PPT and PPS presenta-

tions. The download part of the Open-

Office.org2GoogleDocs extension is still 

in the  experimental stage, and for now, 

you can only open Google Docs docu-

ments in Writer as plain text files.

With this extension, it couldn’t be 

 easier to transfer documents. When 

 installed, it adds a top menu containing 

two commands: Export to Google Docs 

and Import from Google Docs. Simply 

choose the command you need and 

enter your username and password, and 

the extension does the rest.  p

F2 Activate the Formula bar

Ctrl+F2 Open the Fields window

F3  Complete the AutoText entry

Ctrl+F3 Open the AutoText window

F4 Open Data Source View

F5 Turn Navigator on/ off

Shift+F5 Select the next frame

Ctrl+Shift+F5 Turn Navigator on

F7 Evoke spell check

Ctrl+F7 Evoke Thesaurus

F8 Enter the Extension mode

Ctrl+F8 Turn Field shadings on/ off

Shift+F8 Additional selection

F9 Update fields

Ctrl+F9 Show contents of fields

Shift+F9 Calculate table

Ctrl+Shift+F9 Update input fields

Ctrl+F10 Turn non-printing characters on/ off

F11 Turn Stylist on/ off

Shift+F11 Create a new style

Ctrl+Shift+F11 Update style

F12 Turn numbering on

Ctrl+F12 Insert or edit table

Shift+F12 Turn bullets on

Ctrl+Shift+F12 Turn numbering/ bullets off

Ctrl+A Select All

Ctrl+J Justify the selected text

Ctrl+D  Apply double underline attribute to the selected 

text. If the cursor is positioned in a word, this 

word is also underlined.

Ctrl+E Center the selected text

Ctrl+F  Open the Find & Replace dialog window

Ctrl+Shift+P  Apply double superscript attribute to the 

selected text. If the cursor is positioned in a 

word, this word is also double superscripted.

Ctrl+L Align the selected text left

Ctrl+R Align the selected text right

Ctrl+Shift+B  Apply double subscript attribute to the selected 

text. If the cursor is positioned in a word, this 

word is also double superscripted.

Ctrl+Y Redo the last action

Ctrl+1 Apply single line spacing

Ctrl+2 Apply double line spacing

Ctrl+5 Apply 1.5 line spacing

Ctrl+Plus key (+)  Perform a calculation on the selected text. 

The result is copied to the clipboard and can 

be pasted into the document.

Ctrl+Hyphen (-) Insert a hyphen

Ctrl+Shift+Hyphen (-)  Insert a non-breaking dash

Ctrl+* (numeric pad) Run macro field

Ctrl+Space Insert a non-breaking space

Shift+Enter Insert a soft line break

Ctrl+Enter Insert a manual page break

Ctrl+Shift+Enter  Insert a column break in multi-column text

Alt+Enter  Insert a new paragraph without numbering

Alt+Enter  Insert a new paragraph directly before or after 

a section or a table

Arrow Left Move the cursor to the left

Shift+Arrow Left  Move the cursor with selection to the left

Ctrl+Arrow Left  Go to the beginning of the current word

Ctrl+Shift+Arrow Left  Select words to the left from the current cursor 

position

Arrow Right Move the cursor to the right

Shift+Arrow Right  Select characters to the right from the current 

cursor position

Ctrl+Arrow Right Go to the end of the word

Ctrl+Shift+Arrow Right  Select words to the right from the current cursor 

position

Arrow Up Move up one line

Shift+Arrow Up Select lines in the upward direction

Arrow Down Move the cursor down one line

Shift+Arrow Down Select lines in the downward direction

Home Go to the beginning of the line

Shift+Home  Select the current line from its beginning to the 

current cursor position

End  Go to the end of the line

Shift+End   Select the current line from the current cursor 

position to the end of the line

Ctrl+Home  Jump to the start of the document

Ctrl+Shift+Home   Select the text from the document’s start to the 

current cursor position

Ctrl+End  Jump to the end of the document

Ctrl+Shift+End   Select the text from the current cursor position 

to the end of the document

Ctrl+Page Up   Switch the cursor between the text and the 

header

Ctrl+Page Down   Switch the cursor between the text and the 

footer

Insert  Turn the Insert mode on/ off

Page Up  Scroll one screen page up

Shift+Page Up  Scroll one screen page up and select it

Page Down  Scroll one screen page down

Shift+Page Down  Scroll one screen page down and select it

Ctrl+Del   Delete the whole word to the right from the 

 current cursor position

Ctrl+Backspace   Delete the whole word to the left from the 

 current cursor position

Ctrl+Shift+Del   Delete the whole sentence to the right from the 

current cursor position

Ctrl+Shift+Backspace   Delete the whole sentence to the left from the 

current cursor position

Ctrl+Tab   When Automatic Word Completion is turned 

on show the next suggestion

Ctrl+Shift+Tab   When Automatic Word Completion is turned 

on show the previous suggestion

Alt+W   In the spell checker dialog window: Call back 

the original unknown word into the text box

Ctrl+double-click or  Dock or undock the Navigator, Stylist, or other  

Ctrl+Shift+F10  window.
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